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Chapter 1: Introduction to eOPF 
 

OPM is changing the way agencies maintain and access 
official personnel folders.  Human Resources offices across 
the country are changing from a paper-based personnel 
records system to an electronic OPF management system.  In 
the coming months, our current OPF’s will be uploaded into 
the new, web-enabled Electronic Official Personnel Folder 
(eOPF) solution.   
 
The eOPF solution is designed to electronically store, 
manage, and distribute OPF documents.  eOPF stores all OPF 
documents in portable document format (PDF) files.  Every 
employee will be able to access his or her own OPF at any 
time and any place where they can access the internet.   
 
This training session is designed to introduce you to the 
eOPF solution and to familiarize you with the eOPF 
functionalities.  In this class we will be concerned with HR 
Specialists and Assistants accessing their own eOPF as well 
as the eOPFs of their serviced employees.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Chapter 2: Getting Started with eOPF 
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Before using eOPF, you must first login.  Logging in 
requires a valid user name and password. User accounts will 
be set up for all current employees when we first deploy 
eOPF by the use of a PDF Welcome Letter attached to an email 
sent to each employee’s work email address.  The employee 
will use the system generated user ID and the self service 
“Forgot Password” function to request an initial password.  
eOPF will generate an email assigning a new password.  To 
access the eOPF system, each employee must change the 
password to a DOC compliant password.  
 
NOTE: user ID’s and passwords are both case-sensitive.  If 
your logon attempt fails, you will need to wait for one 
minute before your next attempt.  Typically, after three (3) 
consecutive failed attempts to log in to eOPF, that user 
account will be “locked out” as a security precaution.  eOPF 
administrators must reset the user account after the allowed 
number of failed logon attempts. 
 
As with all DOC and NOAA passwords, you must remember to 
safeguard your user ID and password.  Some basic guidelines 
for maintaining your password are as follows: 
 

• Do not share your password with anyone 
• Do not let anyone logon with your eOPF user ID or 

password because eOPF logs and tracks all actions to 
the user ID. 

 
Logging on to eOPF 
 

You must log on to the eOPF each time you want to access the 
system. After you log on to eOPF, you can change your 
password. 
 
To Log on to eOPF: 
 
1. Launch your Internet browser. 
 
2. Maximize the browser to utilize the entire page. 
 
3. Type the designated Address for eOPF:  
 
The eOPF User Agreement page appears. 
 



 3

 
 

4. Click the  Accept button, after reading the User 
Agreement statement. The eOPF Web Logon page appears. 
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5. Type your eOPF ID in the eOPF ID field. 
 
6. Type your Password in the Password field (if you are a 
new user, click on New User – Request your Password). 
 

7. Click the  Submit button. The eOPF Welcome page 
appears. 
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Using the Main Menu Buttons 
 

The eOPF main menu buttons display in the left hand margin 
of your eOPF pages.  
 
Note: 
The main menu options may appear slightly different from the 
example above. The main menu buttons vary depending on the 
eOPF group functional access that has been granted to you by 
the eOPF administrator. 
 

Managing Your eOPF Password 
 
Password Policies 
 
eOPF gives you the ability to change your password at any 
time.  For example, your password may have been compromised, 
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or you may wish to change it to something more easily 
remembered.   
 
Your new password must adhere to the requirements defined by 
DOC. The eOPF administrator can configure the password 
requirement settings such as a 90-day expiration date. 
 
To Change Your Password: 
 

1. From the eOPF Welcome page, click the  
Change Pwd button on the main menu bar. 
 
The Change Password page displays. 

 
 
 
2. Enter your current password in the Old Password field. 
3. In the New Password field, enter your new password. 
4. In the Verify Password field, enter your new password 
again. 

5. Click the  Update button. 
6. For this training, we will not be changing passwords.  

Click the  Cancel button to cancel the password 
change. 
 
Changing Your E-Mail Address 
 
The eOPF solution notifies users via e-mail when new eOPF 
documents are added to their file; therefore, if your e-mail 
address changes it is important that you update it in the 
system. eOPF allows all users to change their e-mail 
address. 
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To Change Your E-Mail Address: 
 
1. Click the Change Email button. The Email Address page 

appears. 

 
 
 
2. Type your e-mail address in the Your Email Address field. 
 

3. Click the  Update button. 
 
The eOPF Welcome page appears with the updated e-mail 
address displayed. 
 
Viewing and Updating Emergency Data 
 
eOPF allows you to enter emergency contact information. This 
information is available to your supervisor and/or HR 
personnel for emergency use only. 
 
To View and Update Emergency Data: 
 
1. Click the Emergency Data button from the main menu. 
 
The Emergency Contact Information page appears. 
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2. Edit the desired fields and click the  Apply 
button. The Emergency Contact Information page reappears 
displaying the message “Emergency data updated 
successfully.” 
 
Accessing Online Help 
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You can access eOPF online help by clicking on the HELP link 
at the top of an eOPF Web page. From the HELP page, you can 
jump to topics of interest. 
 
Accessing Frequently Asked Questions 
 
The eOPF provides access to a Frequently Asked Questions 
(FAQ) page. The FAQ page can be accessed by clicking on the 
FAQ link provided at the top of all eOPF pages. Accessing 
the FAQ page allows access to current eOPF information. For 
example, the FAQ page may post information about: 
 
• Frequently asked questions and answers 
• What’s new 
• Discuss technical issues 
• How to contact eOPF support; and 
• General information about eOPF solution access 
 
Logging out of eOPF 
 
In order to ensure the security of the eOPF solution, 
remember to log out of the system when you are finished. 
 
Note: 
You will be automatically logged out of the eOPF system 
after the system is idle for 15 minutes. (This setting is 
configurable by the administrator.) 
 
To Log out of eOPF: 
 

1. Click the  Logout button. 

2. Click the  OK button to logout of eOPF and 

automatically close the browser window. Click the  
Cancel button to return to eOPF and continue working. 
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Part II – HR Functions 
 

Chapter 3: Viewing eOPF Documents 
 

eOPF organizes and manages personnel documents within an 
electronic folder. Every DOC employees has an eOPF with all 
of his or her personnel documents organized in the same 
manner as the traditional paper OPF.  
 
Once logged into eOPF you can click on either the My eOPF 
button to access your OPF information or the Search eOPF 
button to locate files for your reporting employees.  
 

Viewing Your Own eOPF 
 
1. To view all contents of your eOPF in order by effective 
date, click on My eOPF.  This will bring up your My eOPF 
Results page. Your name is displayed on the upper right 
corner of the page. The My eOPF Results page automatically 
opens your folder and lists its contents.  
 

 
 
To view a document from My eOPF:  
 
2. From the Annotation drop-down list, select whether to 
view the document with or without public annotations. The 
default is to “View documents with annotations”.  As an 
employee you have the right to view the public annotations 
in your folder. 
3. Click the  Action icon corresponding to the document 
you wish to view and select the View option from the drop-
down list.  You will be prompted to open or save the 
document using Adobe reader. 
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NOTE:  
Every time an eOPF document is viewed, that action is logged 
electronically. 
 

 
 
Searching for Specific Documents in your eOPF 

 
You can search for and display specific documents in your 
eOPF using the Search eOPF function.  This may be helpful if 
you are searching for a specific document type or documents 
created in a specified period of time. For more information 
on searching in your own OPF, see pages 18-23 in the eOPF 
User Guide for employees. 
  
Searching for an eOPF: 
 
In eOPF, HR users can search and retrieve documents for an 
individual employee by entering the SSN, employee ID or the 
employee’s name.  HR users can refine the search with other 
parameters, such as document effective date or form type or 
name. A more expansive list of documents from multiple eOPFs 
can be retrieved by using search criteria such as the POI.   
 
You can restrict your search for an eOPF folder by entering 
several criteria on the Search Folders page.   
 
To search for an eOPF: 
 
1. Click the Search eOPF button from the main menu.  The 

Search Folders page opens. 
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This page allows you to query by such fields as SSN and Last 
Name. 
 
2. Enter the search criteria for particular eOPF 

document(s). 
 
Hints:  
 

 Enter SSN with or without hyphens 
 Use the Wild Card (will search on anything before or 
after % sign) 

 Include Empty Folders allows you to list folders with 
no documents, such as those for new employees 
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3. Click the  Search button.  The Search Results 
page appears. On this example, the search may have been 
based on the POI (TEST). 

 

 
 
4. Select a folder by clicking on the Folder icon for the 

folder you wish to see and Select the Open option from 
the drop-down list to display the documents contained in 
the chosen folder. The Document List page displays for 
that folder. 
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-OR-  

Click the  Show All Docs button to list all 
documents that meet your search criteria. The Show All 
Documents page is displayed.   

 
 

 
NOTE: Each time you view an eOPF document that is not 
your own, the action is logged electronically capturing 
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your eOPF ID, date/time, and reason for viewing the 
document. 
 

To search folders by name:   
 
1. On the Search Folders page, enter all or part of the Last 

Name and/or First Name and then click the  Name 
Search button.  

 
This figure shows search results from entering “L” in the 

Last Name field. 
 

 
 
2. Select the Name of the employee by clicking on the radio  

button and then click the  Select button. 
 
The Search page is refreshed and the SSN, first name and 
last name fields are populated with the selected employee  
data. 
 

3. Click the  Search button. 
 
The Search Results page appears. 

 
 
Since Search Results in this example resulted in only one 
folder, the resulting folder is opened in the document list 
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below. 

 
 
 
Viewing an eOPF Document 
 
After you locate an eOPF you can view and/or print a 
document(s) within the folder.  NOTE: you must always first 
enter a reason for accessing the document.  This information 
is recorded in the eOPF history and tracked for audit and 
reporting purposes. 
 
To View an eOPF Document: 
 
1. Search for and locate the eOPF you wish to view. The 

Search Results page appears with a detailed view of the 
employee’s folder. 
 

2. From the Search Results page, click on the Folder  
Action icon and select the Open option to display the 
documents contained in the chosen folder.  

 
This figure displays the Search Results page. 



 17

 

 
 
3. From the Reason drop-down list select a reason for                

viewing this document. If you select Other as the reason 
you must type an additional description in the field to 
the right of the drop-down list. 
 

4. Select whether you want to include any public annotations 
from the Annotation option. 
 

5. Select the  Action icon next to the document you wish 
to view and Select the View option from the drop-down 
list.  This will open the document using Adobe Acrobat 
reader in a new window. 
 
The following figure displays a sample document. 
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6. If the document contains multiple pages, use the Next 

Page and Previous Page buttons to navigate through the 
document. 
 

7. When you finish, click the  Close button to close the 
window. 

8. On the Search Results page, click the  Cancel 
button to return to the search window or select a new 
document to view. 
 

Viewing eOPF Document Annotations 
 
An annotation is a transparent layer of written comments 
placed on top of the document that may be used to highlight, 
markup or write comments.  These layers can be public or 
private.  
  
Documents in the eOPF can be viewed or printed in their 
original state, or with any annotations that have been 
added.  Since annotations are added separately to each page 
of a document, you must navigate to each page to view the 
annotations for that page. To view document(s) with 
annotations: 
 
1. Search for and open the desired eOPF document. 
 
2. If this is not your own eOPF, from the drop-down Reason 

list, select a reason for viewing this document.  
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The “View documents with annotations” is selected by default 
at the top of the display. 
 
3. Open the document by clicking on the  Action icon  

next to the document you want to view. 
 

The document appears in the viewer. 
 

 
 
4. Click on the Next Page and Previous Page buttons if there 

are 2 or more pages to view. 
 

5. Click the  Close button to close the viewer. 
 

6. On the Results List page, click the  Cancel 
button to return to the search window or select a new 
document to view. 
 

Annotating an eOPF Document 
 
eOPF has an annotation feature which allows specified HR 
staff to make notes on documents.  These notes are preserved 
as a layer that sits on top of the original document.  The 
document can then be viewed or printed with our without the 
annotations. 
 
Annotations are added separately to each page of a document.  
eOPF annotations tools allow you to freehand draw, apply 
shapes, add text annotations, and use a highlighter.   
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NOTE: there are two classifications of an annotation: public 
and private.  If you designate an annotation as public, it 
can be viewed, edited, and deleted by anyone with view 
access in eOPF.  Private annotations can be viewed and/or 
edited only by the user and HR staff.  eOPF does not allow 
anyone to annotate their own documents. 
 
 
 
To annotate a page in an eOPF document: 
 
1. Search for and open the desired eOPF document. 

 
2. From the Reason drop-down list, select a reason for 

viewing the document. 
 

3. Open by clicking on the  Action icon corresponding 
to the document you wish to annotate and select Annotate 
from the action option list. 
 

The following figure displays the ActiveView page. 
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4. Click the New button. 

The Private Annotation pop-up box appears. 
 

 
 
5. Select the Yes or No button. The ActiveView page 

reappears. 
 
6. Select the annotation type from the tool list: 

 

 
 
 

7. On the page, use your mouse to add the desired 
annotation(s). 
 

8. When finished adding annotations, click the Done button. 
If you are done using the annotation feature, click the 
Exit button to close the document view window. 

 
For information on removing an Annotation from a Document, 
refer to the eOPF online HELP. 
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Chapter 4: Printing eOPF Documents 
   
Although eOPF is designed as a paperless record, there may 
be times when a hard copy of an eOPF document is needed. 
 
You may choose to print one or more of the eOPF documents.  
The My eOPF option allows you to print one document at a 
time from your own eOPF.  The Search eOPF option allows you 
to print multiple documents from your own or an employee’s 
eOPF. 
 
Printing an eOPF Document using My eOPF: 
 
1. From My eOPF, locate the document you want to print. 

 
2. Open the document using the  Action icon and select 

the View option.  
 

 
3. On the Document View window toolbar, Click the Print 

button. The Print Dialog box opens. 
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4. Modify your printer settings and click the OK button. 
 

5. Click the  Close button to close the document viewer. 
 

Printing eOPF Documents using Search eOPF 
 
eOPF permits you to print documents based on a search query.  
You may print one or more documents directly from that list 
or you can print your results list. 
 
Printing directly from a Search Results page: 
 
1. Search for and open the desired eOPF document. The Folder 

page displays. 

2. From the Folder page, click the  Show All Docs 
button. 

 
The Show All Documents page appears. 
 

  
3. Click the check boxes of the documents you want to print, 

or click the Check All button to print them all.  All 
selected documents are merged into one document displayed 
in the viewer.  

 
4. Click the desired Print button (Double Sided or Single 

Sided). 
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5. If you want to print a copy of your Search Results page, 
click on the Print Window button from your Show All 
Documents page. 

 
See your eOPF online HELP for more information on printing 
from eOPF, such as printing an entire OPF. 

 
 

 
 
 
 
 
 
Chapter 5: Modifying Document 
Indexes 
 
You modify a document index when you want to move a document 
to a different folder or folder section or correct 
information required for the index. 
 
Correcting a Filing Error 
 
This function is used to move a misfiled document to another 
folder.   
 
To Correct a Filing Error: 
 
1. Search for and locate the eOPF document you wish to move 

to a different folder using the Search Folders page.  The 
Search Results page displays. 
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2. From the Search Results page, select a reason from the 

Reason drop-down list. 
 
3. Move a document by clicking on the Action icon 

corresponding to the document you wish to move, and 
select the  Modify Index option.  

 
The Modify Document Index page appears. 
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4. Type the correct employee’s SSN in the SSN field, and 

then click the  Save button.  The Move Document 
confirmation box appears. 

 

 
 

5. Click the  OK button.  The Search Results page 
reappears with the document moved to the correct folder. 

 
For more information on Modifying Document Indexes, refer to 
the eOPF online HELP. 
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Chapter 6: Working with eOPF 
Folders 
 
Employee OPF documents can be accessed from a Results List 
and Show All Documents pages or through the use of paper 
clips.   
 
Working with Search Results Pages 
 
When you elect to show all documents after performing a 
search, you see a list of documents matching your search 
criteria.  A column in the results list indicates if the 
original document was single sided or double sided.  You can 
print your search results list or print a document(s) from 
the list. See Lesson 4 of this guide for more information on 
printing eOPF documents.  Additional information is 
available from Chapter 6 of the Online User Guide. 
  
Working with Paper Clips in eOPF 
 
eOPF provides the ability to paper clip documents from the 
same folder together. eOPF paper clipping allows an employee 
or an HR Specialist to select individual pages within a 
document or entire documents for clipping.  
 
A paper clip can be classified as public or private, with 
the system defaulting to public. Any user accessing the 
selected folder can view a public paper clip.  ONLY the user 
that created the paper clip, a system administrator, or an 
HR Specialist can view a private clip. 
 
Creating a Paper Clip 
 
The first step in using the paper clip is creating a new 
paper clip for a folder: 
 
1. Perform a search for the desired folder(s) using the 

Search Folders page.  The Search Results page displays. 
 

2. Click the Folder Action icon and select the  Clip 
Folder icon for the desired folder. The Clip Folders page 
opens. 

 
 



 28

 
3. Enter a description for the paper clip in the Description 

field, such as FEHB documents or retirement documents. 
 

4. In the Security field, select either Public or Private 
based on your needs. 
 

5. Click the  Insert button. 
 

6. Click the  Back button to return to the search 
result list. 

 
Once a folder has a Clip Folder, documents can be added to 
the Clip Folder at any time. 
 
To Add Documents to a Clip Folder: 
 
1. Search for the document within the folder you wish to 

paper clip.  The Search Results page displays. 
 

2. If this is not your own folder, you must select the 
reason for accessing a document from the Reason drop-down 
list. 

3. On the Results List page, click the appropriate  
Add to Clip icon to add a document to the clip.  The Add 
Clip to Clip Folder page appears. 

 

4. Click the  Select button to add the clip to the clip 
folder.  The Add Page to Clip Folder page appears. 
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5. Click the  Select button to add the clip to the clip 
folder. 
The Add Page to Clip Folder appears. 
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6. Select the additional pages you want to add to the clip 
by checking the Add Page to Clip checkbox under each page 

you want in the Clip Folder, and then click the  
Submit button.  The Search Results page reappears. 
 
NOTE: Click the Back button to return to the previous page. 
 
HINT: you can easily add multiple documents to a clip folder 
from the Show All Docs screen. 
 
Viewing documents within a Paper Clip 
 
Once a paper clip has been created and populated with 
associated documents, you can view a list of the documents 
and open the documents. 
 
To View Documents Contained within a Paper Clip: 
 
1. Search for the desired folder(s) using the Search Folders 

page.  The Search Results page displays. 

 
 
2. From the Search Results page, select the reason for 

accessing the document from the Reason drop-down list. 
 

3. Click on the  Folder Action icon and select the  
Clip Folder icon to show the Clip Folder page for this 
Folder. 
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4. Click the  Detail button next to the desired paper 

clip.  The View Clip Folder page appears. 
 

 

5. Click the  View Clip icon to view the desired document 
within the clip. The document appears. 

 
Refer to the eOPF online HELP for more information on eOPF 
paper clips, including how to remove documents from a paper 
clip. 
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Chapter 7: Adding Documents 
 
eOPF provides the ability to manually add new documents into 
the system by either scanning paper documents or importing 
other electronic files into the database. 
 
Scanning Documents into eOPF 
 
Users can add new documents into the system via scanning.  
Before paper documents are scanned, there are some 
preparation steps that must be performed. 
 
Preparing Documents 
 

• All staples or other metal fasteners must be removed 
 

• Odd-sized documents and poor quality original documents 
should be either photocopied or reduced  

 
• Any folds or irregularities should be straightened 

 
Scanning document(s) 
 
Directions for single-sided and double-sided documents vary 
slightly, so be sure to refer to the correct set of 
instructions in your User Guide, pages 60-64.  In this 
lesson, we will cover single-sided scanning.   
 
1. Search for the folder where the new document belongs 

using the eOPF Search Folders page.  From the Search 
Results page, select the Reason from the drop-down list 
for working on the selected folder. 

2. Click the  Folder Action icon button and select the 

 Add Doc option to add a new document. 
3. Place the document in the scanner (our scanners have 

both a flatbed and a feeder.  For one-sided scanning, 
place your document face down on either.  For double-
sided documents, use the feeder only.) 

4. After the scanning interface opens, click Scan. 
5. Select the following options: 

• Verify ISIS checkbox is unchecked 
• Show Scanner Interface – keep unchecked 
• Form Feeder Multiple Pages – check if doing duplex or 

using the form feeder and then click on the . 
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button. Select the appropriate scanner from the Source 
dialog box and click the Select button.  The document 
appears.  If the document is upside-down, right click 
and choose option to rotate, etc.  Document can be 
magnified at this point and can also be annotated. 

6. Click the  Save button.  The Document Info 
dialog box appears.  The SSN field will already contain 
the SSN of the selected folder.  The first and last name 
fields will also pre-fill. 

7. From the Form drop-down list, select the appropriate 
Form Name. 

8. From the Type drop-down list, select the appropriate 
Form Type. 

9. In the Folder area, select the checkbox representing the 
folder section (Left Side, Right Side) in which the 
document will reside.  eOPF defaults to the folder notes 
in the forms index. 

10. In the Effective Date field, select the appropriate 
effective date of the document from the calendar. 

11. Click the  Save button. The scanning 
application closes and returns you to eOPF. 

12. Verify the information is accurate, and then click Yes.  
A confirmation box appears.   

13. Click the  OK button, then click Close.  A 
confirmation box appears. 

14. Click Yes. 
 
For information on scanning double-sided documents and other 
scanning functions, refer to pages 57-64 in your User Guide. 
 
Importing Electronic Documents Into eOPF 
 
eOPF has the capability to import electronic files.  
Documents in electronic format (image, Word, PDF) can be 
added to an eOPF folder.   
 
To Import an eOPF Document: 
 
1. Search for the employee eOPF for the new document. 
2. Select a Reason for viewing the document. 
3. Click on the  Folder Action icon and select the  

Add Doc icon to add a new document to this folder. 

4. Click the  Open button 
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5. Select the desired file and click the  Open 
button.  The selected file appears. 

6. Click the  Save button. The Document Info dialog box 
appears.  The first name, last name, and SSN will be pre-
filled based on the SSN of the selected folder. 

7. Enter the appropriate information: 
• Form the Form drop-down list. 
• From the Type drop-down list. 
• Select the Folder side the document will reside. 
• Complete the Effective Date field. 

8. Click the  Save button.  
9. Verify the information is accurate, then click Yes.  A 

confirmation box appears. 

10. Click the  OK button. 
11. Click the   Close button. 
12. Click Yes. 
 
Sometime you may need to add a missing page to an electronic 
document. 
 
To Import a New Page Into an Existing eOPF Document: 
 
1. Retrieve and open the desired eOPF document. 
2. Select a Reason code for viewing the document. 
3. Modify a document by clicking on the  Action icon 

corresponding to the document you want to modify and 

select the  Modify icon. NOTE: the only 
modification of the document being done is the addition 
of new pages. 

4. Click the Import button. A confirmation pop-up box 
appears. 

5. Click Yes. The Page Import dialog box appears. 

6. Select the desired document, and then click the  
OK button.  A confirmation box displays – “New Page was 
successfully imported.” 

7. Click the  Close button.  A Close Document confirmation 
box appears. 

 
For additional information on importing electronic documents 
in eOPF see the online HELP. 
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Chapter 8: Working with eOPF 
Reports 
 
The eOPF system allows HR specialists and eOPF 
administrators to view, print, and export standardized 
reports.  The reports are real time data analysis of eOPF 
users, records, and system usage.  The eOPF system 
administrator will create and define the various reports HR 
specialists can access. 
 
There are three major report groups:  Document Access, 
System Access, and System Integrity.  Document Access 
reports list types of actions taken on eOPF documents, by 
who, and when.  System Access reports detail system access.  
System Integrity reports verify data integrity if there is a 
system or hardware failure or some system threat.  Requests 
for any additional reports will go through our eOPF system 
administrator. 
 
Viewing and Printing Logs and Reports 
 
HR Specialists may view and print reports on demand.  The 
procedure is the same for viewing all of the reports. 
 

1. Click the  Reports button.  The Reports page 
appears. 
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2. Select a Report Category, the desired Report, and input 

Report filters. 
 

3. Click the  View Report button.  The Report 
appears. 

 

 

4. Click the  Print button.  The Print Report page 
appears. 
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5. Select All or a group of pages to print, and click the 

 OK button. The report appears as a PDF document. 
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6. Click the  Print button.  The Print setting box 
appears. 

 

 
 

7. Select the desired print parameters; click the  
OK button.   

 
Exporting Logs and Reports 
 
The eOPF system allows HR users and eOPF administrators to 
export the logs and reports.  The same procedure is used for 
all of the reports. 
 
To export logs and reports: 
 

1. Click the  Reports button located on the left-
side menu.  The Reports page appears. 
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2. Select the Report Category, the desired Report, and enter 

report filters. 

3. Click the  View Report button.  The Report 
appears. 

 

4. Click the  Export button displayed on the report. The 
Export Report page appears. 
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5. Select the report format, and click the OK button.  The 

Report appears in the selected format. 
 

 
 
6. Select File→Save As.  The Save As pop-up box appears. 
 



 41

 
 
7. Type the desired document Name, and then click the 

 Save button. 


